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取扱説明書について
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Use of This Manual
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J-2　安全にご使用頂くために SD004-TOS5000A

記号の説明

警告 この表示を無視して、誤った取り扱いをすると、人が死亡または傷害

を負う可能性が想定される内容を示します。

注意 この表示を無視して、誤った取り扱いをすると、物的損害のみの発生

が想定される内容を示します。

安全にご使用頂くために
本アプリケーションソフトウェアを使用する前に、耐電圧試験器本体の取り扱いについて

記述された「TOS5050A/5051A 取扱説明書」をよくお読み頂き、間違った接続や操作のな

いように十分注意してください。間違った接続や操作によって、感電など人命にかかわる

重大な事故を引き起こすことがあります。

TOS5050A/5051A には、作業者の安全をはかるため多くの配慮がなされていますが、試験

器使用中は、被試験物に高電圧が印加されるため、被試験物やテストリード、プローブ、出

力端子周辺等に不用意に触れると感電の危険があります。

試験器および被試験物周辺には、柵を設けて人が近づかないようにするなどの安全対策を

十分に施し、安全の維持、管理の徹底をお願い致します。
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第 1章 はじめに

1.1 本書について

本書はアプリケーションソフトウェア Data Acquisition for TOS5000A（以下DAQ for
TOS5000A と呼びます）について説明しています。

DAQ for TOS5000A は Windows のアプリケーションソフトウェアです。本書では
DAQ for TOS5000A特有の操作や機能についてのみ説明し、Windowsアプリケーショ
ンに共通のことがらについては説明しておりません。Windows の基本的な操作につ
いては、Windows のマニュアルなどを参照してください。

TOS5050A/5051A 本体の取り扱いに関することがらについては、「耐電圧試験器
TOS5050A/5051A 取扱説明書」を参照してください。

適用する製品のバージョンについて

本書はバージョン“1.0x”の DAQ for TOS5000Aに適用します。

1.2 製品の概要

DAQ for TOS5000Aは、当社製耐電圧試験器TOS5050A またはTOS5051A の試験結
果を収集しデータ管理を行うためのソフトウェアです。

DAQ for TOS5000A を使うことで、データの保存・検索・印刷が手軽に行えます。
また、試験の開始・停止もソフトウェアから行うことができます。
SD004-TOS5000A はじめに　J-5



1.3 必要な環境

■パーソナルコンピュータ

■インターフェース

接続には RS-232Cクロスケーブルを使用してください。

1.4 ソフトウェア仕様

*1 市販のキーボード入力タイプ用バーコードリーダを使用すると、入力・実行の
連動操作が可能です。

*2 試験結果は、DAQ for TOS5000A専用のデータベースに逐次保存されます。

CPU Pentium III以上

OS Windows XP, 2000, Me, 98SE（日本語版）

CD-ROM ドライブ DAQ for TOS5000Aをセットアップするときに必要

マウス 必須

ディスプレイ 800 × 600 以上

メモリ 128 MB以上（推奨）

ハードディスク インストールに 50MB 以上の空き容量

RS-232C 転送速度 9600 bps

データビット長 8 bit

ストップピット長 1 bit

パリティビット なし

デリミタの設定 CR+LF

試験 実行・停止機能

シリアル番号の自動インクリメント機能 *1

検索 各データ項目の並べ替え、昇順・降順機能 *2

検索機能（あいまい検索可能）

印刷機能（レイアウト変更可能）

テキストファイル（タブ区切り）、HTML ファイルでの
出力機能
J-6　はじめに SD004-TOS5000A
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第 2章 セットアップ

2.1 パッケージの内容

DAQ for TOS5000Aのパッケージには、以下のものが含まれます。

2.2 DAQ for TOS5000A をインストールする

1. プログラム CD-ROMを PC のドライブにセットします。

しばらくすると、図 2-1のセットアップ画面が自動的に表示されます。
表示されない場合は、CD-ROM を参照し「Setup.exe」を実行してください。

図2-1 セットアップ画面

2. あとは表示される画面に従って、インストールを完了してください。

インストールが完了すると、デスクトップ上には「DAQ for TOS5000A」の
ショートカットアイコンが作成されています。

図2-2 ショートカットアイコン

品名 数量

プログラムCD-ROM 1

ユーザーズマニュアル（Z1-003-160） 1



第 3章 DAQ for TOS5000A の基本

3.1 DAQ for TOS5000A を起動する

準備

1. 試験器（TOS5050A/5051A）の POWERスイッチをOFF にします。

2. PCと試験器を RS-232Cクロスケーブルにて確実に接続します。

デフォルトではCOM1 ポートを使用しますが、複数の通信ポートを持つPC で
はDAQ for TOS5000Aが使用するポートを変更できます。ポートの変更につい
ては、「3.4 通信ポートを変更する」を参照してください。

起動

3. デスクトップ上にある　「DAQ for TOS5000A」のショートカットアイコン を

ダブルクリックします。

図3-1 の起動画面が表示されます。

図3-1 起動画面

RS-232C の接続

起動画面が現れたら RS-232Cを介して PC と試験器を接続します。

4. 試験器のPOWER スイッチをON にします。

この時点では、試験器との接続は切れているので、図 3-2 のように“接続ラン
プ”は赤色です。また、［状態 / 結果］表示は“－”になっています。
J-8　DAQ for TOS5000A の基本 SD004-TOS5000A



図3-2 未接続状態

5. ［接続する］ボタンをクリックします。

接続されると、“接続ランプ”は緑色になります。また、［状態 /結果］表示は
“READY”になります。
ただし、試験器が“PROTECTION”状態のときは［状態 / 結果］表示も
“PROTECTION”になります。

図3-3 接続状態

■接続状態にならないときは

接続や設定が正しくないと、図3-4 のようなエラーメッセージが現れます。メッセー
ジを確認したら、起動手順をもう一度実行してみてください。

図3-4 エラーメッセージ例

・ 接続した状態（緑色ランプ点灯時）で、試験器のPOWER スイッチを OFF にし

て、また ONにした場合、　表示は接続状態のままですが、実際のRS-232C 接続
は切れています。必ずアプリケーション側でも、［切断する］ボタンをクリック
し、再度［接続する］ボタンをクリックして再接続してください。

接続ランプ状態 / 結果表示

注記  
SD004-TOS5000A DAQ for TOS5000A の基本　J-9



3.2 画面構成

DAQ for TOS5000Aは、試験と検索の 2つの画面から構成されています。

試験画面

試験結果のデータを収集します。試験の実行には、ローカルモードとリモートモー
ドの 2つがあります。

ローカルモードでは、試験データの収集と結果の表示が主な機能です。
リモートモードでは、さらに試験の開始と停止も PCから実行できます。

図3-5 試験画面

検索画面

検索画面では、収集した試験データから条件に合致したデータだけを検索し表示で
きます。また、検索したデータを印刷したり、他のアプリケーションで利用可能な
テキスト形式で保存できます。

図3-6 検索画面

試験 / 検索
画面切り替え

ツールバー

ステータスバー

RS-232C の
接続 / 切断

リモート操作ボタン表示項目

試験結果リスト

ローカル / リモート
モード切り替え

設定項目

メニュー

試験 /検索
画面切り替え

ツールバー

ステータスバー

検索開始ボタン

検索条件

試験結果リスト

メニュー
J-10　DAQ for TOS5000A の基本 SD004-TOS5000A



画面の説明

試験画面

検索画面

*1 入力できる最大文字数は 128文字です。「”」、「%」、「’」は入力できません。
*2 次の試験が開始されるまで表示は変わりません。
*3 あいまい検索が可能です。

設定項目

次のシリアル番号 *1 次に試験する被試験物のシリアル番号を入力します。

インクリメント

このチェックボックスをオンにすると、［次のシリアル番号］
の数字が自動的に 1つ増加します。
連続した 15桁までの数字に対して正しくインクリメントしま
す。

メモ *1 被試験物に関するメモを入力します。

TOSシリアル番号 *1 試験器のシリアル番号を入力します。

表示項目*2

シリアル番号 被試験物のシリアル番号が表示されます。

状態 /結果 試験中は“TEST”、試験終了後は結果が表示されます。
RS-232C 接続時は“READY”が表示されます。

経過時間 試験の経過時間が表示されます。

リモート操作ボタン

開始 リモートモード時に試験を開始します。

停止 リモートモード時に試験を停止します。

ローカル / リモート
モード切り替え

このチェックボックスをオンにすると、リモートモードにな
ります。

試験結果リスト 試験結果が表示されます。表示する項目は［表示］メニュー
＞［設定］＞［リスト項目］で設定できます。

検索条件

下記の検索条件を設定
する（And 検索）

このチェックボックスをオンにすると、検索条件を設定する
ことができます。
複数の条件項目を設定している場合は And 検索となります。

開始日時 検索条件に試験の開始日時を加えます。
yyyy/mm/dd の形式で入力します。

シリアル番号 *3 検索条件に被試験物のシリアル番号を加えます。

TOSシリアル番号 *3 検索条件に試験器のシリアル番号を加えます。

メモ *3 検索条件に被試験物に関するメモを加えます。

判定 検索条件に試験の判定を加えます。

モード 検索条件に AC耐電圧試験、または DC耐電圧試験を加えま
す。

検索開始ボタン 検索を開始します。

試験結果リスト 試験結果が表示されます。表示する項目は［表示］メニュー
＞［設定］＞［リスト項目］で設定できます。
SD004-TOS5000A DAQ for TOS5000Aの基本　J-11



3.3 メニュー構成

メニュー項目 説明

ファイル

テキストファイル
で保存

試験結果リストに表示されている試験データをテキスト形式
（タブ区切り）のファイルで保存します。

起動時に検索条件
でデータを取り込
む

この項目を選択（チェックマークを付加）すると、DAQ for
TOS5000A 起動時に専用データベースに格納されている試験
データを取り込み試験結果リストに表示します。
検索条件が指定されている場合は、その条件のデータが読み
込まれます。

印刷プレビュー 試験結果リストに表示されている試験データの印刷イメージ
を表示します。

終了 DAQ for TOS5000Aを終了します。

編集

コピー 選択されている試験データをクリップボードへコピーします。

すべてを選択 試験結果リスト内の試験データをすべて選択します。

編集
選択されている試験データの［シリアル番号］、［メモ］、およ
び［TOS シリアル番号］を変更するダイアログボックスを表
示します。

削除 選択されている試験データを専用データベースから削除しま
す。

表示

ツールバー この項目を選択（チェックマークを付加）すると、ツール
バーを表示します。

ステータスバー この項目を選択（チェックマークを付加）すると、ステータ
スバーを表示します。

設定 試験結果リストの表示項目、印刷項目、環境設定を変更する
ダイアログボックスを表示します。

ヘルプ

バージョン情報 DAQ for TOS5000Aのバージョンを表示します。

ツールバーのみの項目

降順で並べ替え 試験結果リスト内の選択した項目をキーにして試験データを
ソートします。

昇順で並べ替え 試験結果リスト内の選択した項目をキーにして試験データを
ソートします。

並べ替えなし ソートした試験データを元の順序に戻します。
J-12　DAQ for TOS5000A の基本 SD004-TOS5000A



3.4 通信ポートを変更する

DAQ for TOS5000Aが使用する通信ポートは、デフォルトでは COM1ポートを使用
します。ただし、複数の通信ポートを持つ PC では DAQ for TOS5000A が使用する
ポートを変更できます。

1. ［表示］メニューから［設定］を選択し、［環境設定］タブをクリックします。

2. ［通信ポート No.］のドロップダウンリストから使用するポート番号を選択し
ます。

図3-7 通信ポートの変更
SD004-TOS5000A DAQ for TOS5000Aの基本　J-13



第 4章 データの収集

4.1 データ収集のための 2つのモード

DAQ for TOS5000A には試験データを収集するモードとして、つぎの 2 つのモード
があります。

■ローカルモード

試験データの収集のみを行います。試験の開始（または停止）は試験器のパネルス
イッチから行います。

■リモートモード

試験データの収集に加えて、試験の開始（または停止）を PCから行います。

例えば、市販のキーボード入力タイプ用バーコードリーダを使用すると、被試験物
に貼られたシリアルナンバーのバーコードを読み込むことによって試験を開始さ
せることも可能になります。

・ RC01-TOS などのリモートコントロールボックスで試験器を操作する場合は、
ローカルモードで使用してください。リモートコントロールボックスが試験器
に接続された状態でリモートモードは使用できません。

ローカルモードとリモートモードの切り替え

DAQ for TOS5000A を起動し、RS-232C を介して PC と試験器が接続されると、図
4-1 のような試験画面でローカルモード、［状態 /結果］表示は“READY”となります。

図4-1 RS-232C 接続時の画面

注記  

試験が選択

チェックなし
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2 つのモードの切り替えは、試験画面の
［リモート］チェックボックスで行いま
す。図 4-2 を参照してください。

リモートモードでは、［開始］と［停止］
ボタンが有効になります。このボタン
が試験器パネルの［START］と［STOP］
スイッチと等価になります。

4.2 データを収集する

4.2.1 準備

試験器側

1. 試験器のパネルから耐電圧試験の試験条件を設定します。

2. 試験器と被試験物をテストリードで接続します。

DAQ for TOS5000A 側

1. ローカルモードまたはリモートモードどちらかを選択します。

2. 試験画面の設定項目に必要な情報を入力します。

図4-3 設定項目

［インクリメント］のチェックボックスをオンにすると、［次のシリアル番号］
（被試験物のシリアル番号）の数字を自動で 1つ増加します。

この機能がオンの場合でも［次のシリアル番号］には、文字や数字を自由に組
み合わせて入力できます。インクリメントする数字は自動検出され、対象とな
る全角文字は半角文字に変換されます。
連続した 15桁までの数字に対して正しくインクリメントします。

（例）　２３ＳＮ００８８ＡＢＣを入力して試験を開始した場合

実行中のシリアル番号は、２３ＳＮ００ 88ＡＢＣ
インクリメントされたシリアル番号は、２３ＳＮ００ 89ＡＢＣ
となります。

ローカルモード リモートモード

図 4-2 モードの切り替え

入力できる最大文字数は 128文字です。
「”」、「%」、「’」は入力できません。
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4.2.2 試験の開始と停止

ローカルモード

試験の開始

1. 試験器パネルの［START］スイッチを押します。

試験の停止

1. 試験器パネルの［STOP］スイッチを押します。

試験器のタイマー機能がONの場合は、設定時間経過後自動で停止します。

リモートモード

リモートモードでは、試験器パネルのディスプレイに“REMOTE”と表示されま
す。この状態では、パネルの［START］スイッチは無効になりますが、［STOP］ス
イッチは機能します。

試験の開始

1. 試験画面の［開始］ボタンをクリックします。
またはキーボードのEnter キーを押します。

図4-4 の確認メッセージが表示されます。

2. ［OK］ボタンをクリックします。
またはキーボードの左方向（←）キーで［OK］ボタンを選択し、Enter キー
を押します。

図4-4 確認メッセージ

このメッセージを省略して、1 ステップで試験を開始することができます。詳
しくは、次のページの「■確認メッセージを省略する」を参照してください。

試験の停止

1. 試験画面の［停止］ボタンをクリックします。
またはキーボードのEnter キーを押します。
試験器パネルの［STOP］スイッチでも停止できます。

試験器のタイマー機能がONの場合は、設定時間経過後自動で停止します。
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■確認メッセージを省略する

［表示］メニューから［設定］を選択し、［環境設定］タブをクリックします。

図 4-5 の［安全対策］のチェックボックスをオフにすると、試験開始時に確認メッ
セージが表示されなくなります。

確認メッセージを省略すると、キーボードの Enter キーのみで試験を開始すること
が可能になります。例えば、バーコードリーダの入力に同期して試験を開始するこ
とも可能です。

・ 確認メッセージを省略すると、試験器から離れた場所でキーボードの Enterキー

を1回押すだけで試験が開始されます。
確認メッセージを省略して使用する場合は、不用意に高電圧が発生することの
ないよう、安全には細心の注意を払わなければなりません。

図4-5 環境設定

警告 
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4.2.3 状態表示

試験画面の［状態 /結果］には、試験の開始から終了後の結果が表示されます。［状
態 /結果］表示は次の試験が開始されるまで変わりません。

図4-6 状態 /結果表示

4.2.4 画面の最小化

DAQ for TOS5000Aの画面を最小化にすると、図 4-7 のような画面に変わります。

この画面は、ローカルモード時は状態 /結果を表示するだけです。
リモートモード時はこの画面から試験の開始と停止が可能です。

図4-7 最小化画面

表示 説明

READY RS-232C接続時に表示されます。

TEST 試験中を表します。

PASS 試験時間内に不合格でなかったことを表します。

STOP 強制的に試験を停止させたことを表します。

U_FAIL 試験中に測定した漏れ電流値が、設定した上限
基準値以上であったことを表します。

L_FAIL 試験中に測定した漏れ電流値が設定した下限基
準値以下であったことを表します。

PROTECTION 試験器の保護機能が動作したことを表します。

状態 /結果

開始

シリアル番号 経過時間

停止
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第 5章 データの管理

5.1 試験結果リストの操作

表示項目を選択する

試験結果リストに表示する項目を選択できます。

［表示］メニューから［設定］を選択し、［リスト項目］タブをクリックしてください。

図5-1 リスト項目の設定

デフォルトではすべての項目が選択されています。項目の前のチェックボックスを
オフにすると、リストには表示されなくなります。

表示項目を並べ替える

リストに表示される項目の順番を並べ替えることができます。

例えば、判定を一番右にするには、図 5-2 のように［判定］のラベルをドラッグし
てシリアル番号の前に持っていきます。

図5-2 表示項目の並べ替え（判定項目の例）

ここをドラッグ
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データをソートする

指定した項目をキーにして、リストに表示されるデータをソートすることができま
す。

例えば、判定をキーにしてソートするには、図 5-3 のように［判定］のラベルをク
リックします。

図5-3 データのソート（判定項目の例）

クリックするたびに［判定］の右に三角形のシンボルが現れ、次のようにソートさ
れます。選択されている項目はツールバーのアイコンでもソートできます。

列幅を調整する

リストに表示される項目の列幅を調整することができます。

例えば、判定の列幅を調整するには、図 5-4 のように［判定］のラベルの右をドラッ
グします。

図5-4 列幅の調整（判定項目の例）

リスト内の選択した項目をキーにして試験データを降順で
ソートします。

リスト内の選択した項目をキーにして試験データを昇順で
ソートします。

ソートした試験データを元の順序に戻します。

ここをクリック

ここをドラッグ
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5.2 データを編集する

収集された試験結果は DAQ for TOS5000A 内部の専用データベースに格納されま
す。このデータの一部の項目は後から編集することができます。

試験結果リストから編集したい試験データを 1つ選択し、［編集］メニューから［編
集］を選択します。

図5-5 試験データの編集

［シリアル番号］、［メモ］、および［TOS のシリアル番号］を編集できます。

入力できる最大文字数は 128文字です。「”」、「%」、「’」は入力できません。

データベースから試験データを削除する

試験結果リストから削除したい試験データを 1 つまたは複数選択し、［編集］メ
ニューから［削除］を選択します。

・ この操作はデータベースから試験データを完全に削除します。削除されたデー

タはもとに戻すことはできません。

注意 
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5.3 データを検索する

デフォルトでは DAQ for TOS5000A 起動時、試験結果リストには過去に取得した
データは表示されません。試験を行う度に試験結果リストに試験データが表示され
ていきます。

過去に取得した試験データは専用のデータベースに格納されており、必要な時に呼
び出すことができます。データベース内のすべての試験データを呼び出すことが可
能ですが、条件に合った試験データだけを呼び出すことも可能です。

試験データを検索するには、DAQ for TOS5000Aを検索画面にします。

図5-6 検索条件

データベース内の全ての試験データを取り込む

［下記の検索条件を設定する］のチェックボックスをオフにし、［検索開始］ボタン
をクリックします。

条件にあった試験データだけを取り込む

［下記の検索条件を設定する］のチェックボックスをオンにします。その下ある条
件項目の中から、必要な項目のチェックボックスをオンにし、条件を入力します。
複数の項目を設定した場合は、And 検索となります。

条件を入力したら、［検索開始］ボタンをクリックします。

項目 説明

開始日時 試験の開始日時をyyyy/mm/dd（年 /月 /日）の形式で
入力します。

シリアル番号*1 被試験物のシリアル番号を入力します。

TOSシリアル番号 *1 試験器のシリアル番号を入力します。

メモ*1 被試験物に関するメモを入力します。

判定
試験の判定を入力します。
ドロップダウンリストからPASS、U_FAIL、L_FAIL、
STOP、または PROTECTIONの何れかを選択します。

モード ドロップダウンリストからAC 耐電圧試験、またはDC
耐電圧試験のどちらかを選択します。

*1 あいまい検索が可能です。例えば、［シリアル番号］に“AB”と入力して検索する
と、“23SN001ABC-YK”のような文字列も検索します。
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・ 検索によって試験結果リストに表示された試験データを単にリストの表示対象
から除外する機能はありません。必要でないデータを表示対象から除外するに
は、さらに絞り込み検索を行うか、またはデータベースから該当データを削除
してください。

起動時に既存の試験データを取り込む

［ファイル］メニューから［起動時に検索条件でデータを取り込む］を選択（チェッ
クマークを付加）すると、DAQ for TOS5000A 起動時に専用データベースに格納さ
れている試験データを取り込み試験結果リストに表示します。

検索条件が指定されている場合は、その条件のデータが読み込まれます。

5.4 テキスト形式でデータを保存する

試験結果リストに表示された試験データをつぎの3つの方法でテキスト形式のデー
タとして保存できます。

1.　クリップボードを利用する

試験結果リストから保存したい試験データを 1 つまたは複数選択し、［編集］メ
ニューから［コピー］を選択します。選択した試験データはタブ区切りのテキスト
としてクリップボードにコピーされますので、他のアプリケーションに貼り付けて
利用することができます。

2.　テキストファイルで保存する

試験結果リストに表示されている試験データをタブ区切りのテキストファイルと
して保存できます。

［ファイル］メニューから［テキストファイルで保存］を選択します。保存するファ
イル名は、デフォルトでは“Tos+ 現在の時間”になります。

（例）　Tos2004 年 01 月 09 日 14 時 50 分 03 秒 .txt

3. HTMLファイルで保存する

試験結果リストに表示されている試験データを印刷プレビュー画面から HTML（ま
たはテキスト）形式のファイルで保存できます。詳しくは「5.5 データを印刷する」
の「 印刷プレビューをHTML ファイルで保存する」を参照してください。

注記  
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5.5 データを印刷する

試験結果リストに表示されている試験データを印刷することができます。

検索画面で［ファイル］メニューから［印刷プレビュー］を選択してください。

図5-7 印刷プレビュー画面

印刷するには

1. 印刷プレビュー画面で印刷ボタンをクリックします。

印刷ダイアログボックスが現れます。

2. ［印刷］ボタンをクリックします。

図5-8 印刷ダイアログボックス

・ 印刷ダイアログボックスでは用紙のサイズや向きを変更しないでください。
DAQ for TOS5000Aはリアルタイムにその変更を反映しません。
用紙のサイズや向きを変更するには、Windows の［スタート］メニューからプ
リンタ設定を選択してください。変更は DAQ for TOS5000A の再起動後に有効
となります。

印刷ボタン エクスポートボタン

タイトル

印刷項目

文字数

注記  
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印刷タイトルや項目を変更する

［表示］メニューから［設定］を選択し、［印刷項目］タブをクリックしてください。

図5-9 印刷項目の設定

デフォルトでは［シリアル番号］から［下限電流］までの5 つの項目が選択されて
います。項目のチェックボックスをオンすると、その項目が有効となり印刷される
ようになります。

［順番］は項目の並びを指定します。“1”に指定した項目が一番左になります。

［文字数（幅）］は各項目の列幅を指定します。有効な項目の文字数合計と用紙サイ
ズの目安は以下のようになります。

［タイトル］欄に入力した文字列は文書のタイトルとして印刷されます。

・ 用紙のサイズや向きの変更に対して、DAQ for TOS5000A はリアルタイムにその
変更を反映しません。
用紙の幅に対して文字列合計が適しているにもかかわらず、図5-10 のようなエ
ラーメッセージが現れる場合は、一旦 DAQ for TOS5000A を終了し、再度起動
してください。

図5-10 エラーメッセージ

用紙サイズ 文字数合計

A4縦 約100 文字

A4横 約150 文字

注記  
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印刷プレビューをHTML ファイルで保存する

1. 印刷プレビュー画面でエクスポートボタンをクリックします。

エクスポートダイアログボックスが現れます。

2. ファイル名を入力し、［保存］ボタンをクリックします。

図5-11 エクスポートダイアログボックス

［ファイルの種類］をテキストファイルに指定すると、印刷プレビューをテキスト
形式でも保存できます。
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Safety Precautions

 

Before using this software application, please thoroughly read the 

 

TOS5050A/5051A
Operation Manual

 

 that describes the handling of the Withstanding Voltage Tester.
Use extreme caution to avoid improper connection and operation. Improper connec-
tion or operation can lead to serious accidents such as an electric shock that may
result in fatal injury.

The tester is equipped with various safety features to protect the operator from haz- 
ards. However, when the tester is in use, high voltage is applied to the DUT. Inadvert-
ently touching the DUT, test leads, probes, and output terminals can cause electric
shock.

Be sure to provide full protective measures around the tester and DUT to prevent
electric shock – such as to enclose the test area with rope fences to prevent access.

 

Definition of Symbols

 

Indicates a potentially hazardous situation which, if
ignored, could result in death or serious injury.

Indicates a potentially hazardous situation which, if
ignored, may result in damage to the product and
other property.

WARNING
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Chapter 1 Introduction

1.1 About This Manual

This manual describes the software application, Data Acquisition for TOS5000A
(DAQ for TOS5000A).

DAQ for TOS5000A is a Windows software application. This manual describes the
operations and functions that are specific to DAQ for TOS5000A. Common opera-
tions of Windows applications are not covered. For a description of the basic opera-
tion of Windows, see the Windows manual or other related documents.

For information about the handling of the TOS5050A/5051A Tester, see the
TOS5050A/5051A Withstanding Voltage Tester Operation Manual.

Product version covered
This manual applies to DAQ for TOS5000A Version 1.0x.

1.2 Product Overview

DAQ for TOS5000A is a software program used to acquire the test results from the
Kikusui TOS5050A or TOS5051A Withstanding Voltage Tester and manage the
data.

DAQ for TOS5000A enables the user to easily save, search, and print the data. The
program can also be used to start and stop the tests.
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1.3 System Requirements

■ PC

■ Interface

Use a RS-232C cross cable for the connection.

1.4 Software Specifications

*1 Test results are saved sequentially to a database dedicated to DAQ for
TOS5000A.

CPU Pentium III or higher

OS Windows XP, 2000, or Me  (English version)

CD-ROM drive Needed to set up DAQ for TOS5000A

Mouse Required

Display 800 × 600 resolution or higher

Memory 128 MB or more (recommended)

Hard disk Free space of at least 50 MB to install the program

RS-232C Baud rate 9600 bps

Data bit length 8 bits

Stop bit length 1 bit

Parity bit None

Delimiter setting CR+LF

Test Start/Stop function

Automatic increment function of the serial number

Search Data item sorting function (ascending or descending order)*1

Search function (with like search capability)

Print function (with layout modification capability)

Save function to text files (tab separated) or HTML files
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Chapter 2 Setup

2.1 Package Contents

The DAQ for TOS5000A package contains the following items.

2.2 Installing DAQ for TOS5000A

1. Insert the program CD-ROM in the CD-ROM drive of your PC.

After a few moments, the setup screen shown in Fig. 2-1 appears automati-
cally.

If the screen does not appear, browse the CD-ROM and run “Setup.exe.”

Fig.2-1 Setup screen

2. Install the program according to the instructions shown on the screen.

When the installation is complete, the DAQ for TOS5000A short cut icon is
created on the desktop.

Fig. 2-2 Short cut icon

Item Quantity

CD-ROM containing the program 1

User’s Manual (Z1-003-160) 1



Chapter 3 DAQ for TOS5000A Basics

3.1 Starting DAQ for TOS5000A

Preparation

1. Turn off the POWER switch on the tester (TOS5050A/5051A).

2. Securely connect the PC and the tester using an RS-232C cross cable.

By default, the COM1 port is used. However, on PCs that have multiple com-
munication ports, the port that DAQ for TOS5000A uses can be changed. For
instructions on changing the port, see section "3.4 Changing the Communica-
tion Port".

Starting the program

3. Double-click the DAQ for TOS5000A short cut icon  on the desktop.

The startup screen shown in Fig. 3-1 opens.

Fig.3-1 Startup screen

Connecting the RS-232C cable

When the startup screen appears, you will connect the PC to the tester via the RS-
232C cable.

4. Turn on the POWER switch on the tester.

At this point, the connection to the tester is not yet established, and the connec-
tion lamp is red as shown in Fig. 3-2. In addition, the Status/Result display
shows “–.”
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Fig. 3-2 Not connected

5. Click the Connect button.

When a connection is established, the connection lamp turns green. In addi-
tion, the Status/Result display shows “READY.”

However, if the tester is in “PROTECTION” mode, the Status/Result display
also shows “PROTECTION.”

Fig. 3-3 Connected

■ If a connection cannot be established

If the connection or setup is not correct, an error message appears as shown in Fig.
3-4. Check the message and carry out the startup procedure again.

Fig. 3-4 Error Message Example

• If you turn off the POWER switch on the tester and turn it back on while the con-
nection is established (while the green lamp is illuminated), the display keeps
indicating the connection established state, but the actual RS-232C connection is
cut off. In such cases, be sure to click the Disconnect button and then click the
Connect button again on the application to reestablish the connection.

Status/Result display Connection lamp

NOTE
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3.2 Screen Construction

DAQ for TOS5000A consists of two screens: Test and Search.

Test screen

The test screen is used to acquire test result data. There are two modes for test exe-
cution: local mode and remote mode.

The main functions of local mode are the acquisition of the test data and displaying
of results.

In addition to the functions provided in local mode, remote mode also provides the
function of starting and stopping tests.

Fig. 3-5 Test screen

Search screen

The search screen enables you to search and display only the data that matches the
specified conditions from the acquired test data. You can also print the searched data
or save the data in text format for use in other applications.

Fig. 3-6 Search screen

Menu

Toolbar

Switch between
Test and

Search screens

Status bar

Setup items

Display items Remote control button

Connect/Discon-
nect the RS-232C

Switch between 
local and remote 
modes

Test result list

Menu

Toolbar

Switch between
Test and

Search screens

Status bar

Search conditions

Search start button

Test result list
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Screen description

Test screen

Search screen

*1 Up to 128 characters can be entered. The following characters are not allowed: ”, %, and ’.
*2 The display does not change until the next test starts.
*3 Like search is possible.

Setup items

Next Serial Number*1 Enter the serial number of the next DUT to be tested.

Increment
Select this check box to automatically increment the Next Serial 
Number value.
The value is incremented correctly on up to 15 consecutive digits.

Comment*1 Enter a comment for the DUT.

TOS Serial Number*1 Enter the serial number of the tester.

Display items*2

Serial Number Displays the serial number of the DUT.

Status/Result
Shows “TEST” while a test is in progress. Shows the result after a 
test is completed.
Displays “READY” when connection is established via RS-232C.

Elapsed Time Displays the elapsed time of the test.

Remote control button

Start Starts the test when in remote mode.

Stop Stops the test when in remote mode.

Switch between local and 
remote modes

Select this check box to enter remote mode.

Test result list
Displays the test results. You can set the items that are displayed by 
choosing View > Setup > List Items.

Search conditions

Set the search conditions 
below (And search)

Select this check box to set search conditions.
If multiple conditions are specified, search is made on the AND logic 
of the conditions.

Start Date
Adds the test start date to the search conditions.
Enter the date in the following format: mm/dd/yyyy.

Serial Number*3 Adds the serial number of the DUT to the search conditions.

TOS Serial Number*3 Adds the serial number of the tester to the search conditions.

Comment*3 Adds the comment for the DUT to the search conditions.

Judgment Adds the test judgment to the search conditions.

Mode
Adds AC withstand voltage test or DC withstand voltage test to the 
test conditions.

Search start button Starts the search.

Test result list
Displays the test results. You can set the items that are displayed by 
choosing View > Setup > List Items.
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3.3 Menu Structure

Menu Item Description

File

Save to a Text File
Saves the test data displayed in the test result list to a file in tab-sepa-
rated text format.

Load Data on the 
Search Conditions 
at Startup

If you select this item (add a check mark), the test data that is stored 
in the dedicated database is loaded when DAQ for TOS5000A is 
started and displayed in the test result list.
If search conditions are specified, the data under the conditions are 
loaded.

Print Preview
Displays the print image of the test data displayed in the test result 
list.

Exit Closes DAQ for TOS5000A.

Edit

Copy Copies the selected test data to the clipboard.

Select All Selects all the test data in the test result list.

Edit
Opens a dialog box used to change the Serial Number, Comment, 
and TOS Serial Number of the selected test data.

Delete Deletes the selected test data from the dedicated database.

View

Toolbar Select this item (add a check mark) to show the toolbar.

Status bar Select this item (add a check mark) to show the status bar.

Setup
Opens a dialog box used to change the displayed items and printed 
items of the test result list and the environmental settings.

Help

About Displays the version information of DAQ for TOS5000A.

Items available only on the toolbar

Sort in descending 
order

Sorts the test data using the selected item in the test result list as a 
key.

Sort in ascending 
order

Sorts the test data using the selected item in the test result list as a 
key.

No sort Reverts the sorted test data to the original order.
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3.4 Changing the Communication Port

By default, the communication port that DAQ for TOS5000A uses is COM1. How-
ever, on PCs that have multiple communication ports, this port can be changed.

1. From the View menu, choose Setup. Then, click the Environmental
Settings tab.

2. From the COM Port Number drop-down list, select the port number.

Fig. 3-7 Changing the communication port
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Chapter 4 Data Acquisition

4.1 Two Modes for Data Acquisition

There are two modes for acquiring test data on DAQ for TOS5000A.

■ Local mode

Only acquires the test data. The test is started (or stopped) from the tester’s panel
switch.

■ Remote mode

In addition to acquiring the test data, test is started (or stopped) from the PC.

• If you are controlling the tester through a remote control box such as the
RC01-TOS, use local mode. You cannot use remote mode when a remote
control box is connected to the tester.

Switching between remote and local modes

When you start DAQ for TOS5000A and a connection is established between the
PC and the tester via the RS-232C, the test screen in local mode appears as shown in
Fig. 4-1. The Status/Result box shows “READY.”

Fig.4-1 Screen when a connection is established via the RS-232C

NOTE

Check box not 
selected

Test is
selected
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To switch between two modes, use the
Remote check box on the test screen.
See Fig. 4-2.

In remote mode, the Start and Stop
buttons become available. These but-
tons correspond to the START and
STOP switches on the tester panel.

4.2 Acquiring Data

4.2.1 Preparation

On the tester

1. Set the conditions for the withstanding voltage test from the tester
panel.

2. Connect the tester and the DUT using test leads.

On DAQ for TOS5000A

1. Select local mode or remote mode.

2. Enter the necessary information for the setup items of the test screen.

Fig. 4-3 Setup items

Select the Increment check box to automatically increment the value in the Next
Serial Number (serial number of the DUT) box by 1.

You can enter combinations of characters and numbers in the Next Serial Num-
ber box even when this function is on. The number that is incremented is detected
automatically.

The value is incremented correctly on up to 15 consecutive digits.

(Example) If you enter 23SN0088ABC and start the test, you will get the following:

The serial number of the test being executed is 23SN0088ABC.

The incremented serial number is 23SN0089ABC.

Local mode Remote mode

Fig. 4-2 Switching modes

Up to 128 characters can be entered. The following 
characters are not allowed: ”, %, and ’.
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4.2.2 Starting and Stopping Tests

Local mode

Starting the test

1. Press the START switch on the tester panel.

Stopping the test

1. Press the STOP switch on the tester panel.

If the test’s timer function is on, the test stops after the specified time elapses.

Remote mode

In remote mode, the test panel display shows “REMOTE.” In this condition, the
START switch on the panel is disabled, but the STOP switch is enabled.

Starting the test

1. Click the Start button on the test screen.
Or, press the Enter key on the keyboard.

2. Click the OK button.
Or, press the left arrow (←) key on the keyboard to select the OK button
and press the Enter key.

Fig. 4-4 Confirmation message

Stopping the test

1. Click the Stop button on the test screen.
Or, press the Enter key on the keyboard.
You can also press the STOP switch on the tester panel.

If the test’s timer function is on, the test stops after the specified time elapses.
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4.2.3 Status Display

The Status/Result box on the test screen shows the status of the test and the result
after the test. The Status/Result display does not change until the next test starts.

Fig. 4-5 Status/Result display

4.2.4 Minimizing the Screen

Fig. 4-6 shows the screen that appears if you minimize the DAQ for TOS5000A
screen.

This screen only shows the status and result in local mode.

In remote mode, you can start and stop the test from this screen.

Fig. 4-6 Minimized screen

Display Description

READY Displayed when a connection is established via the RS-232C.

TEST Indicates the test is in progress.

PASS Indicates that a failure did not occur during the test time.

STOP Indicates that the test was stopped manually.

U_FAIL
Indicates that the leak current measured during the test was 
above the specified upper limit reference.

L_FAIL
Indicates that the leak current measured during the test was 
below the specified lower limit reference.

PROTECTION Indicates that the protection function of the tester tripped.

Serial number Elapsed time

Status/Result

StopStart
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Chapter 5 Data Management

5.1 Manipulating the Test Result List

Selecting the Displayed Items

You can select the items that are displayed in the test result list.

From the View menu, choose Setup. Then, click the List Items tab.

Fig.5-1Setting the list items

By default, all items are selected. Clear the check boxes in front of the items to stop
them from appearing in the list.

Rearranging the displayed items

You can rearrange the order of the items that are displayed in the list.

For example, to move the Judgement item to the right-most position, drag the
Judgement label in front of the serial number as shown in Fig. 5-2.

Fig. 5-2 Rearranging the displayed items (Judgement item example)

Drag this
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Sorting the data

You can sort the data displayed in the list by making a specified item the key.

For example, to sort the data using Judgement as a key, click the Judgement label
as shown in Fig. 5-3.

Fig. 5-3 Data sorting (Judgement item example)

Each time you click the Judgement item, a (dsc) or (asc) appears to the right of the
label, and the data is sorted as described below. You can also use the icon on the
toolbar to sort by the selected item.

Adjusting the column width

You can adjust the column width of the items displayed in the list.

For example, to adjust the column width of Judgement, drag the boundary line to
the right of the Judgement label as shown in Fig. 5-4.

Fig. 5-4 Column width adjustment (Judgement item example)

(dsc)
Sorts the test data using the selected item in the list as a key in descending 
order.

(asc)
Sorts the test data using the selected item in the list as a key in ascending 
order.

Reverts the sorted test data to the original order.

Click here

Drag this
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5.2 Editing the Data

The acquired test results are stored in a database dedicated to DAQ for TOS5000A.
Some of the items of the data can be edited afterwards.

Select a test data point that you wish to edit from the test result list. Then, choose
Edit from the Edit menu.

Fig. 5-5 Test data editing

You can edit Serial Number, Comment, and TOS Serial Number items.

Up to 128 characters can be entered. The following characters are not allowed: ”, %,
and ’.

Deleting test data from database

Select one or multiple test data points that you wish to delete from the test result list.
Then, choose Delete from the Edit menu.

• This operation deletes the test data completely from the database. You
cannot recover the data that you have deleted.

CAUTION
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5.3 Searching the Data

By default, the test result list does not show data that was acquired in the past when
DAQ for TOS5000A is started. The test data is shown in the test result list each time
a test is carried out.

The test data acquired in the past is stored in a dedicated database, and you can
recall the data when necessary. You can recall all of the test data in the database or
recall test data that matches certain conditions.

To search the test data, switch to the Search screen of DAQ for TOS5000A.

Fig. 5-6 Search conditions

Loading all of the test data in the database

Clear the Set the search conditions below check box and click the Start
Search button.

Loading only the test data that matches certain conditions

Select the Set the search conditions below check box. Select the check boxes
for the condition items you need and enter the conditions. If multiple items are spec-
ified, search is made on the AND logic of the conditions.

After entering the conditions, click the Start Search button.

• There is no function for hiding certain test data points from the test result list that
is displayed by the search function. If you wish to hide unneeded data, you must
narrow down the search further or delete the data from the database.

Item Description

Start Date Enter the start date of the test in mm/dd/yyyy format.

Serial Number*1 Enter the serial number of the DUT.

TOS Serial Number*1 Enter the serial number of the tester.

Comment*1 Enter a comment for the DUT.

Judgment
Enter the judgement of the test.
Select PASS, U_FAIL, L_FAIL, STOP, or PROTEC-
TION from the drop-down list.

Mode
Select AC Withstanding Voltage Test or DC Withstand-
ing Voltage Test from the drop-down menu.

*1 Like search is possible. For example, enter “AB” in the Serial Number box and carry 
out the search. Text containing the characters such as “23SN001ABC-YK” is also 
searched.

NOTE
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Loading existing test data at startup

If you select Load Data on the Search Conditions at Startup from the File
menu (add a check mark), the test data stored in the dedicated database is loaded
and displayed in the test result list when DAQ for TOS5000A starts.

If search conditions are specified, the data under the conditions are loaded.

5.4 Saving the Data in Text Format

The test data shown in the test result list can be saved to a text file in one of three
ways described below.

1. Using the clipboard
Select one or multiple test data points that you wish to save from the test result list.
Then, choose Copy from the Edit menu. The selected test data is copied to the clip-
board as tab-separated text, and you can paste the data to other applications for use.

2. Saving to a text file
You can save the test data shown in the test result list to a tab-separated text file.

From the File menu, choose Save to a Text File. The name of the file is
“Tos+current time” by default.

(Example) Tos_jan092004_145003.txt

3. Saving to an HTML file
The test data shown in the test result list can be saved to an HTML (or a text) file
from the print preview screen. For details, see “Saving the print preview to an
HTML file” in section "5.5 Printing the Data".
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5.5 Printing the Data

The test data shown in the test result list can be printed.

On the search screen, choose Print Preview from the File menu.

Fig. 5-7 Print preview screen

Printing the Data

1. Click the Print button on the print preview screen.

The Print dialog box opens.

2. Click the Print button.

Fig. 5-8 Print dialog box

• Do not change the paper size or orientation in the print dialog box. DAQ for
TOS5000A does not apply the change in real-time.

To change the paper size or orientation, select printer setup from the Windows
Start menu. The change takes effect after restarting DAQ for TOS5000A.

Print button Export button

Title

Print items

Number of characters

NOTE
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Changing the printed title and items

From the View menu, choose Setup. Then, click the Print Items tab.

Fig. 5-9 Setting print items

By default, the first five items from Serial Number to Current Lower Limit are
selected. If you select the check box, the item is enabled (the item will be printed).

Order specifies the order in which the items are arranged. The item set to “1” is
printed at the left end.

Number of Characters (Width) specifies the column width of each item. Below is
the guideline to the total number of characters of all enabled items and the paper
size.

The text entered in the Title box is printed as the title of the document.

• DAQ for TOS5000A does not apply paper size and orientation changes in real-
time.

If the total number of characters are correct for the paper size, but an error mes-
sage shown in Fig. 5-10 appears, close DAQ for TOS5000A and start it again.

Fig. 5-10 Error message

Paper size Total number of characters

A4* portrait Approx. 100 characters

A4* landscape Approx. 150 characters

* A4 is an ISO paper size close to the US letter size.

NOTE
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Saving the print preview to an HTML file

1. Click the Export button on the print preview screen.

The Export dialog box opens.

2. Enter a file name and click Save.

Fig. 5-11 Export dialog box

You can also save the print preview to a text file by setting the Save as type box to
a text format.
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